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PART OF THE MINISTRY OF JUSTICE -

PART 1 — PREPARING DOCUMENTS ,,
STEP1 Collate your documents

e From the Combine tab select Merge Files into a single PDF...
Inserting additional documents

e Select the Document tab and choose the Insert Pages->From Fiig..;ff:-;\i

PART 2 — HIGHLIGHTING FOR PEER REVIEW \5__({;%:. D
p Ny
STEP 2  Mark up sections for redaction /Z\\“

s On the Advanced tab, select Redaction->Show Redact:ongaﬁo!bar
e On the Redaction Toolbar select Mark for Redactions. Q\:\\

s Highlight the Tools tab and select Comment & Markip=s"Text Box Tool

e Click next to the area for redaction and drag to thhefosest blank space. A text

box will appear. Type the reason you wish to vgltm'ipld the section e.g. s 9(2)(a).

.y

Search for words/phrases é /
e Select the Search and Redact tab from the Rgdactfon toolbar.
STEP3 Add page numbering ‘\.\\;_\\}
¢ Select the Document tab and choose, Hegder & Footer -> Add....
e Inthe Page Number and Date Forhqﬁf Box select “Page 1 of n” format from the
w8
Page Number Format dropbo o ?\\ y
e Click your mouse into the mqht FOoter Text space and click Insert Page Number.

STEP4 Add document number{flg

/s
e From the Tools tab seﬂa;{ Comment & Markup->Text Box Tool.

(
STEP5 Send through peer‘"‘re\gllew process

/

&/
STEP6 Compile Tabié ofdocuments for release

\\z

e Use the;TabIe““of Documents template and compile the documents for
releasg
PART 3 - PREPARING’ FINAL DOCUMENT
STEP 7 Applyﬂnal redactions
° '/On_}the Redaction Toolbar, select the Apply Redactions tab.

STEP Sé“f.\\_wAddlng the OIA release watermark

r‘*f\:.\ gf) On the Document Tab select Watermark-> Add....
{ :::\"B
,STEP9 Filing of OIA documents
{.r & 0\«

e File the scanned final version of the OIA in the X:Drive and hole punch the
physical copy ready for filing by you or support staff - as per filing arrangement
in your specific team.

{OTE: See full guide for detailed instructions and advice on converting file types to PDF,
peer reviewing using Adobe Reader and reasons for withholding information.
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1. This guide is designed to step you through using Adobe Acrobat Pro to;
a. Provide a simple yet efficient way to mark and apply redactions to documents
b. Produce a professional document to the requestor that is easy to orientate and visually
consistent across the Office of Treaty Settlements and the wider Ministryﬁ ice.

2. If you have any questions about any of the steps or information in this guitﬁi@ontact

Hamish Kirk -

3. NOTE: Please remember to log off the computer when not in use and k Ze OIA desk area tidy
for the benefit of other users.

%R
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PART ONE

Step 1: Collate your documents

documents must be in PDF format. —>

See Appendix One for further information on how to convert word and email f[les t%); PDF and/or
how to remove protection from PDF/A type files. q-p‘»_b ~

N
€y

i ‘{\‘}:;Z 2=
If the following method fails to work, please print out all your documen aéd csan them all to

PDF in the order you wish to send to the requestor. A\

Name each PDF chronologically with year/month/day format E{ g.

“20160131_Document x”;
“20160317_Document y”;
”20140928 Document z”.

Make sure the PDFs are in chronological order fro_" j
This will help to arrange the PDFs in the correft oi‘di—fr for the final document release.

Tools Advanced Wndow Help

;;‘ Create * :'.j Combine * &z ‘,r’i Sagn = EJ Forms = h Multimedsa # Comment »

Assemble POF Poy
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8. Drag and drop all the relevant files for redaction in to the Combine Files box.

(Gl ) comkens @ Ao @ e

'm M Vew Tosh Help
B Cpon nth Adche Feaswr ] Pomt

e
W AddFaes o @ SagePCd  POFReicle
[

| Drag and drop files to sdd them, and then arrange them In the order you want.

| tirme Prgefarge Sire Medfed  Wermgulmon
|

|

AN a

9. If any of your documents are not in PDF format (see 2 a&&t_@}) you will not be able to add them to

the collated PDF and you will receive the following error.
o,

L.ndd Files.. = _’2

° Slng\e PDF

@ Please remove problem files from the llsl or

Hame

Al Pages
AllPages
AllPages 4

B Marsnga s € e v o ngé h
%2 The Vibe - 15 July 16.df

b
5. The Vibe - 1 Aug 16,pdf 4 73551 KB

# Remove

he Portfolio option.

Wanipg
I -‘ convert file ¢

annot conwe t file type to PO

File Size:

POF Portfolio

&0 3

s
| Cancel |

10. Files may sh Wa warning but still be capable of being merged. The Combine Files button (in the
bottom rightshand corner in the diagram above) will be greyed out if Adobe Pro is unable to

progé%??‘
11. Al
f}[éf

e is too long.

eCk the length of the individual file names — Adobe Pro will fail to convert some files if the
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12.

13.

14.

15.

Arrange the files in the correct order you wish to have them in for the final document releas;(\

If you have labelled all your files chronologically as in Step 1(3) above they will already be@

-

ng ibottom left

correct order from oldest to most recent document.

You can arrange the files by simply clicking and dragging them into the order you
selecting the file you wish to move and clicking the Move Up or Move Down buf
of screen).

Modified

Name

5 The Vibe - 1 Aug 16.pdf
15 July 16.pdt

Page Range
All Pages
All Pages
All Pages

;a1 Vibe
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16. Name the file accordingly and select Save to keep a copy of the collated PDF.

17. Use the following format “YYYYMMDD — OIA 5XXXX — Stage of Review”.
e.g. “20161031 OIA51234 RAW”.

7 save s " N g
T cetrm
G Name A Date modified Type
ESI S 0(0)()(v) | 8/09/2016 345 p.m.  File folder \
Recent Places  f1pemo1.2 9/09/201610:35 2...  Adobe Ac
T0emo1 24/08/2016 10:21 2., Adobe Ac

Djsldc;p g
=

Libraries

u‘ki

Computer

@ .

Network ¢ | ool

File pame:

Save as bype: Adobe PDF Files (" pdf) = b oo Cancel

18. If you have documents you wish to add afta;%n)\ave already collated the PDF, first make sure
you have the collated PDF containing yo({oc ment(s) open.

Step 1.1 Inserting additional documents

19. Make a note of which page you waégocument to appear.

20. Select the Document tab and % the Insert Pages->From File....

The Vibe - 1 Aug

Fle Edt View | Advanced Vindow Help

Commerty_Fomtgh 16
Header & Footer »

Baciground

| & |

& Create * “

st Cute T
Shifte CtleR

|JusTCE

Eamine Document...
Cempyre Documents ..
Add Bookmark
Attach s fite.

s
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21. Select the document/PDF you wish to add to the collated PDF as below.

"
%
N

tookin: - ERSIEBIGIN - @M@

P

@ Name Date modified Type
""} TiEmail 1 16/08/2016 2:37 p.... Adobe Ac

Recent Places &mﬂmﬁﬁ‘ 2/08/20168:10 am.  Adobe Ac
- "* The Vibe - 15 July 16 - 2/08/2016 8:10 a.m. _ Adobe Ac
Desktop
=l

Libraries

i

Computer

@' L P R

Network el e B
Fite pame: The Vibe - 15 July 16 hd

{Adobe PDF Fies (pdi)

22. You will then be presented with the opportunity to decide where the document will appear in

the collated PDF. \V"

23. Choose Before or After from the Location d@ depending on your preference.

24. You may also specify whether you waQe ocument to appear in relation to the first, last or a

specific page.

Insert Pages
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26. NOTE: You may also use these functions to reorder the documents after completing redaction:

¢

27. If you would like to remove a page select Delete Pages from the Document page. (\ _ ﬁ

28. Choose the page range and select OK. ~

29. T,}j_"i%;p\é?g’é order will be rearranged. You may need to update the page numbering (described
bel@wﬂn Step 3).
P

™1 Demo 1.2.pdf - Adobe Acrobat Pro _
Fite Edit View JIREEEN Comments Forms Tools

ed Window Help st T M

:_] Create » ,,! Ltader & Fogler Y- Ei Forms « &y Mullimedia « P Comment *
: - - Background 4 2oAtL

Watermark » U efg W 0% . iv-i L"Id P
Insert Pages » = -

t P st
S Bages , Redaction Properties 'l;-’!' Search and Redact

Split Documen

ShiftsCuleT

Crop Pages...

Rofate Pages... ShifteCtrl+R
54, Scanto POF »

Optimize Scanned PDF

OCR Text Recognition

Reduce File Size..,

Examine Document...

Compare Documents...
Add Bookmark Ctil+B

& Attach a file..,

>
Jy o

& & |
P o W |

-3

=

lropedies  |<HW Search and Redact

~ I
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Step 2: Mark up sections for redaction
1. To begin marking up areas suggested for redaction go to the Advanced tab and select @fon—
>Show Redaction Toolbar.

PART TWO &
O

- = 9 &::esslbllrty
i Create ~ Combine ~ Secure » Sig r
"J ‘J u f 7 A Sign & Certify

f J__.J ﬁ .| i..,.._'J W' ’ 1 /8 Ik .SCSU"tY

Security Settings...

Manage Trusted [dentities...
Extend Features in Adobe Reader...

ﬂ Off’ce of Tr Prm: Production ‘ . . -
Settlement Redadon " 0N 7 L Markfor Redaction

/ Document Processing } | |Bf Mark Page Range
Web Capture |

» 2k Apply Redactions
} {5 Redaction Properties

PART OF THE MINISTRY OF

POF Optimizer...

File Edit View anunt Qomments FozmsT ols -” ned 7 7‘ .

:] Create ~ ﬁCombinev W Secure 'lgSign* L=] Forms ~ E Multimedia ~ :_?Comment'
De e AING § 00 mn - e

x®

| |[Redaction =
i lz Mark for Redaction

‘A Search and Redact

Office of Treauy
Settlements

Redaction Tool Properties
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3. Select the Redacted Area Fill Color as black. NB: Black will be clearer to the requestor &

4. Select OK to apply the changes to the Redaction Tool. < )

Redactian Tool Properties T =
5 _ ,_H ARG
! Appesrance lGenmI

l Redacted Area Fil Cnlnr. Use Overay Text

Overlay Text

Eﬂl’lt [HC[HE‘ICE el gl T

Fent Size: |10 |} Auto-Size test to fit redaction regian
Font Color. (I [ | Pepeat Ovetlay Test - Q

& E W

Text Alignment:
(@ Custom Text:
Redaction Code:

Code Sets:

MZ 0141922

ll lLocked

2} Demo 1.pdf - Adobe Acrobat Pro

Eulf__@im !lew roument Qomw_ents Fo ~ Tools. Advanced !{ndow Help N e A e )
_.j Create ~ *} Combine ~ u Se@ Sign ~ |_] Forms ~ E Multimedia ~ ’f Comment ~
[ B R O?Q“ RO 2% ek i

Redaction
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6. Use the mouse to click and drag the redacting tool across the text/area you wish to redact. &

7. Once the above action is completed, if you hold the mouse over the redacted section, ym@‘i@
see how the section appears when redactions are applied. %‘;Z},

8. To delete a marked up area you wish to change or remove simply click on the ma %\%wea for
redaction and press delete on the keyboard. Qj

9. Areas marked for redaction will be outlined in red (as below) when you sav@%@ print out the
document.

T 180 Yoo Deowmart Gommarrs frgms Tovn dbonced Wedoe biey
&) trve &n«n—- B e /u.- ]t iy MRmasa s D oot »

T . = @ 1 NS mE s e

> B " - H&S Update

'(u.n-m.u- e By Pedacham j\m..u-r-m \_gw..nwm..n

| have been contempla(ing the health and safety (H&S) landscape here at OTS (read %ﬁ asking the question 'ls our H&S approach
here right?, and by this | mean:

. Are people adequately informed about both employer and employee nsibilities, apropos H&S?

. Are there facilities, policies and tools provided by the employer that eﬁhﬁ ployees feel safe at work?

| think these two questions will do for reflection at the moment. | am biased in my answers, but {believe that through a variety o
[venues; this article Included, there Is a pervasive desire to have informati ormed employees here at That desire is
manifest In the Information smorgashord available on the MOJ website, | about the shop, the H&S induction programme, and

occasionally | get up and update people about H&S developments at sta etings. As to the policies and tools, the answer there is
related to question one, yes there are facilities and toals. The critlcal then seems to be, are there too many or too few H&S

obligations that are either hindering people unreasonably, or exppsing ge Ie to unnecessary risks, in performing their daily tasks?
about it and see if you agree. Any feedback is welcome. Regards

My perception is that we have got the balance about rlght H
Jon Cotton, your H&S rep.
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10. Highlight the Tools tab and select Comment & Markup -> Text Box Tool

*] Creste ~ g Combine = “ B , Comment & ' Sticky Hote
] Select & Zoom Tet Edits -
| L_‘ H ﬁu ” il L I.Aduncedidal-ng 7 7; Stamps LB
Gl Typeitic »| i Highlight Text Tool
- Anstysis ,f ] Undeline Text Tool
Multimedia 'I ] Cross Out Text Tool
I | £ Attach a file as 3 Comment
| & Record Audio Comment
l a Paste Clipboarg Image as Stamp Tool

Cystomize Toolbars...

| / LineTool

1 have been contemplating the health and safety‘ L1 Bectangle Teol
here right?, and by this | mean: | O Oyal Tool

. Are people adequately informed aboy ¢ PebacntineTocl
. Are there facilities, policies and tools | 0 ftnled
2 !/Emul'l'oul

I think these two questions will do for reflection |#~ Penci Erser Tocl
fvenues; this article included, there is a pervasiv ™ oy
manifest in the information smorgasbord availak
occasionally | get up and update people about H&S developments at staff meetin
related to question one, yes there are facilities and tools. The critical matter the
obligations that are either hindering people unreasonably, or exposing peopl

ke Comment & Markup Toolpar

'"' shop, the H&S induction programme, and
to the policies and tools, the answer there is
e to be, are there too many or too few H&S

essary risks, in performing their daily tasks?

11. Using the tool click next to the area for redaction and drag'to the closest blank space. A text box

will appear. w

e.g. s 9(2)(a) for withholding personal
ér reviewer chooses to print out copies for peer
will be able to see the reason for redaction.

12. Type in the reason you wish to withhold the sé
information. The reason for this is that if your
review, the peer reviewer (and the requ r)

£ 20161010 OMASorx RAW i - Ad5ES Airobal Fro
(Fle B View Document Comments Forms Took ﬂﬂﬂ'ld _Windew

&) Croste - .‘)cm ﬂ P& [_jrum EM:M
R B fi-'n 1k

) sickytets .gmm & 4 W =2 }”.r.uu
wmmumm- &Wmm .@ &pmww

| have been conte

herellghl? andBy th ean:
eople adequately informed about both employer and employee responsibilities, apropos H&S?

‘e fagilities, policies and toels provided by the employer that ensure employees feel safe at work?

Are

dnformation smmgasbord available on the MOJ website, pnsters all about the shop, the H&S induction programme, and
mallfbget up and update people about H&S developi at staff . As ta the policies and tools, the answer there is

6l.to quesmm one, yes there are facilities and tools. The critical matter Ihen seems to be, are there too many or too few H&S

that are either hindering people unreasonably, or exposing people to unnecessary risks, in performing their daily tasks?
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13. You are able to adjust the size of the text box by clicking and dragging on its edges. &

14. Right click on the text box and select properties. \

siytiote [l Tatbans &+ ) B\ = @ 4 /0O O s ( )

o MukterRedscion » (5l ApplyRedscions %) (AN Sesrch and Redact v-

e at OTS (read MOI) and asking the question 'ls oy HES approFed
s 9(2)(a)
d employee responsibilities, apropos H&S? §

sloyer that ensure employees feel safe at work?

site, posters all about the shop, the H&S induction programme, an
1 staff meetings. As to the policies and tools, the answer there
I matter then seems to be, are there too many or too few H&

ng people to unnecessary risks, in performing their daily tagks
sink about it and see if you agree. Any feedback is welc egards

Delete

Show Comments List

Make Current Properties Default

B s

T
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Thickness: [Lpt

Eill Color: )]

Style: -

Border Color: [?:]

Using Adobe Reader on your own computer once redactions are marked up
g

16. NOTE: To improve the availability of redaction sggti?g?é computers, make an initial text box and
save the collated PDF. .

17. Return to your computer and open the col!&tgdd)%F in Adobe Reader (it will open in Reader by
default). f{-ﬁ v

18. You can copy the text box, paste it and;’\ezd\it% =

=y 2

allowing you to mark up your reasons for
redactions without the redaction sgﬁ'@ﬁ (Adobe Pro).
19. This will free up a redaction co;pu terfor another colleague.
&

“«q?:@"?
a
e'to
N

Step 2.1 Search for words/pb‘i‘fa}et redact

9

20. Adobe Acrobat Pro gii%iypu the ability to find and redact words or phrases. This may be useful
for redacting namg%. N
Y
21. NOTE: For be%*qs&q- Its, carry out all word/phrase searches at the beginning of marking up the

collated PDEi(i;%ﬁ%Before marking up any sections manually).

. J

Q,\\““ : b}
22, Search_ing“ﬁa\‘gwords or phrases will depend on the software’s ahility to perform Character

Rec@ﬁfﬁ?on on the particular page of the collated PDF (i.e. handwritten notes would not be
p@%}xp by the software).
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23. To search for common phrases within the collated PDF select the Search and Redact tab from
the Redaction toolbar. A\

! Demo Lpdf - Adobe Pro ( )
fle Edt View Document Comments Forms Tools Advanced Window Help
;,J Create » &J Combine * a Secure * ’ Sign v ‘!i Forms * ﬂ Multimedia ~ :_f Comment ~ ;2

u H B L_J - ‘ 1 /8 lk .‘\:’ji Q | - ") 203% I_b-,f t’d Find
sz . a4 o
Iiwmhn

L{ Mark for Redaction = |5y Apply Redactions ,@ Redaction Properties
L. ; ol MR,
| have been contemplating the health an@ y (H&S) i
here right?, and by this | mean:

PDF.

Adobe Acrobat ﬁ —— N

&« Documents can contain images and line at appear as text but are not
lé searchable. These items will not be Search and Redact. Please review
your documents carefully to ensuré thathall sensitive information is properly

marked for redaction. \
L

["]iDo not show this message agaiM

; O Co D

25. Although this might be a USW as suggested in the prompt above, please check the
&
documents thoroughly f(}!&%ﬂg this to ensure you have marked all relevant information for
redaction.
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26. You can search for single words or phrases. In the below example the word ‘process’ has beK
chosen.

m Arrange Windows

Where would you like to search?

@ d@the current document >
i ) All PDF Documents in

[| (b My Documents /

| Search for:

@ Single word or phrase
1 S\ Multiple words or phrase

() Patterns

What word gy

| process

[ ] Whole words only
("] Case-Sensitive

check the individual instances. :

29. If you hover the mouse overa’check box it will show which page the instance of that word is on.

30. When you are happy 'th your selection, select the Mark Checked Results for Redaction button.

' \\co..\Demo Lpdf

R T T S T R TR R B AT o
ettle » The tacnga displays have recently been refreshed and expanded as part of
Jhagement Process (HEP), and it's been focused on how to give expression in

T negotiating process. Here | will name names, because Aaron Randall, Tom Bisley, Sam Anderson,
the process followed to reach them, which suggests that yes, perh hing has ch d
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31. Once words have been marked up, you can input text boxes as shown in Step 10 to note t@)

reasons for redaction.

32. If there is space it is preferable to click and drag the text box to a nearby blank pa

v

%ﬁe screen

so ideally no text is obstructed. .
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Step 3: Add page numbering ffe;

Once you have added all the documents and marked up the redactions with reasons, nun‘@er)

the pages. ﬁj;?ﬁ?

Page numbering is important for ease of reference for peer reviewers and the reqy—é:t%\v

The reason for adding page numbering after you mark up the collated PDF f(}&g‘dﬁion is the
order of the documents is less likely to change. N i

It is also useful in numbering individual documents within the collated ﬁ%{iés it helps identify

the page range an individual document is found on. Q@:ﬁ

ey

To add page numbers select the Document tab and choose He@ ‘Footer -> Add.....

You will need to update the page numbering every time afeg:{éearra nging or deleting pages as
this is not automatic. If updating the page numbering cxiggi’;’fé”?%eader & Footer -> Update...

instead.
| Demo Lpdt - Adobe Acrobat Pro

Multimedia + 7
e Background jaste.., T

e ﬁ E‘j Watermark

Insert Pages Qb e et e
Extract Pages...

Replace Pages... : Redaction Properties Cﬂ‘ Search anc

Delete Pages...

St Dosment-e we have got the balanc
Crop Pages... ifts Ctrls T e

| Rotate Pages... Shift+Ctrl+R p '

.":-:J Scan lo&I ’

| Qptimize Scahned PDF

0 Recognition » e ————

File Size...
e , Goings and

Ctrl=B
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7. Inthe Header and Footer properties box change the colour of the font from black to red by
choosing red from the colour palette as shown below. This will help the font become more

visible to the reader. ( )

8. NOTE: If you are simply updating the page numbering for the collated PDF go straight toaicking
OK at the bottom of the Header and Footer properties box.

9. Select the Page Number and Date Format... option in the properties box.

Add Header and Footer

Saved Settings: [VICunom-nal Lli:!d]

Font

Mame: | Anial

Appearance Options.., i :
ElEEEN i'

Left Header Text Center Header Test /o O (ED(Z) BN L Jar Tent
Other Color.. W

Left Footer Test Center Footer Tex Right Footer Text

| X | |
g \C} (ietonn] G

Office of Treaty
B Eettlements

retated to qubstion of 5 t| rumfuiuulndlom ‘lhemhlmm:rﬂwnmmwbe lrtthmmmmronoofewﬂls
oN'auonslﬁmue itherhinderi bly, of exposing people to unnecessary risks, hnﬂformhlmdﬂylukﬁ

1 am:mqmob mntmnmmmnm-mmnmummmsmabmdnem., -
Jon Cotton, i

} l é;ply1uMuﬁipk j | VCIm:.d
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10. In the Page Number and Date Format Box select “Page 1 of n” format from the Page Number
Format dropbox. Click OK. &

=

Page Number and Date Format

Date Format:

Page Number Format:

Start Page Number:

|
il

I e

11. Click your mouse into the Right Footer Textsspace and click Insert Page Number.
Saved Settings: [Custom-not saved] i v ) Delete \
Font Margin (Centimeters)
Name: [_Arial \bQ7 v] Size: 8 v E] Top: 127 |l Bottom: ’0-9 i

Appearance Options... Left 21 |1 Right [t )

i
Left Header Tex} % Center Header Text Right Header Text
Left Fo:@ Center Footer Text Right Footer Text

<<Pagel of n>>
vlew

Preview Page Il ‘:J‘ of 8 Page Range Options...

k OK on the Add Header and Footer box to apply the page numbering to the entire
Q/ document.
Q}\/ Page 21 of 41

s

Page Number and Date Format...




@)
E-‘\ ; r_}?
13. You should now see the page numbering applied to the entire document as shown in the ¢ N
example below. '{x N

G g u--..g-#. e
T B o Dorart (o fun fohy il i (o »
o) s it [ s e (B b [ et D o

I BB . 88 'O R &8~
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Step 4: Add document numbering

1. Numbering the documents is another important step for orientation by the requestor. ‘ )

2. Document numbering should be located at the top right corner on the first page of each 2
document.

3. From the Tools tab select Comment & Markup->Text Box Tool. @

2 Demo 1.2,pdf - Adobe

File Edit View Document Comments Forms 74&9\@!1595!”” a i
::] Create = @ Combine = a Secure ~ y

Select & Zoom »

O LD R 2 /8 ncedEditing »|  Stamps »
. | T - Typewriter » | {8 Highlight Text To prrr—
BT s +| @ Undetine T ve a think

i lz Mark for Redaction ~ Lo hpely BY D Multimedia » 5] Cross Qut Fex
L 7 & £i

Customize Toolbars... s

Cmings, Goi

| “ i i} Rectangle Tool
) Oyal Tool

{* Polygon Line Tool

) Polygon Tool

./ Pencil Tool

" Pencil Erager Tool

i1 Show ’

Show Comment & Markup Toolbar
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4. Alternatively from the Tools tab select Comment & Markup->Show Comment & Markup Toolbar.

m Demo 1.2.pdf - Ad:be.ﬁ at P
File Edit View Document Comments Forms A#M ﬁgiinidqw Help LA 0 i

7 . — 7] =
: sj Create ~ ij Combine ~ ﬂ Secure v /1128 t&Markup | o Sticky Note
— Select & Zoom ¥ [&] TeaEdits ’
' H v . s 2 . 2 /8 Advanced Editing 4 [ Stamps |
1 . s Typewriter » (7] Highlight Text Tool -
S (Redaction Anibigsis | ] Underline Text Tool O ve a thi
4 IZ Mark for Redaction » | Apply o Multimedia » %] Cross Out Text Tool \
1 T &2 Attach a File as a Comment
= verdskais 4 Record Audioc Comment

&% Paste Clipboard Image Tool
=N, Callout Tool § pe———

¥ [=] Text Box Tool

2 Cloud Tool
A Arrow Tool
/ Line To

] Rectang
onlg!
o ine Tool

n Tool

encil Tool
4 Pencil Erager Tool

f) Demo 1.2,pdf - Adobe Acrobat Pro I
File Edit View Document Comments Forms JGoIey, Atvanced Window Help

ﬁj Create ~ 'ij Combine ﬂ Secure'le [E] Forms ~ ﬁ Multimedia _“'? Comment ~
DU es U R[®e % [ :

| b L R . .
Redaction 7 - xput right. Hav
! [Z Mark for Redaction ~ .,Npl:_, Redachons Redaction Properties H‘ Search and Redact

| V4

®

Comings, Goings and Opportu

with OTS on | il _ Ist. He and

Y.
((;f/ Page 24 of 41
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6. Inthe top right corner of the first page of the specific document, click and create a text box.

£ Dero 12p1 - Ade h
e 61 View Docomert Commerts boom Tock Adiaaced Wandon Hely

: ;jtu‘--. &]c.m- .ﬁ tewes F sgnn ;:I;].!m' & Mnﬁ"‘_-?(m‘
DML #@ 1 0 h G & pen i
. ut right. Have a think about it and see if you agree. Any feedback is welcome.‘sards

A Redusien Pregenien H\mmmr

?—-—lu.h' ) ) O
v teaybete [ 1] Teatdne & - d; Dy =l AL VE] O J e

Comings,

|t cretes L) comboa s ) Secunn s # tgne (8] e [y tbimesss 1D Commint+ \\
EEER L e 2
Redection == oo ) ¥put right, Have a think abeyt d see if you agree. Any feedback is welcome. Regards
A Mastfer Redacten = Sapey esros %) Redection Propertes &m.ﬁh«mr \

o e Wreatsr Ge )N 5O A OO S e

9. Right click on the text box and selec erties.

| y A
see if you ﬁ@ Any feedback is welcome. Regards

e

S.glsmusr ;

Show Comments List

Make Current Propesties Default
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10. In the Text Box Properties box, change the Border Colour to Red.

11. Change the Opacity to 40%. ( )

12. As you did with the Text Box in Step 2 (15), mark the Make Properties Default checkbox sz that
every subsequent Text Box you create has these properties as default.

13. Click OK to proceed.

Callout Properties

Appearance [General | Review H|story|

\
Line Ending: Thickness: lpt =l
Border Color: @

| F &
S

| [
I ["Locked {¥IiMake Properties Default oK Cancel [

14. The document number will now be visible but will not obscure any information should there be
any in the top right corner of t age.
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Step 5: Compile Documents Table for release £

Adjust/finalise the Documents Table for release to the requestor. Ensure the following fle{ds aﬂxe
included; -

e Document Number

¢ Date of document

e Description of document

e Reason for withholding

e Page Number (the document begins at).

To ensure a standardised Documents Table is used across the office, pl

provided here

Step 6: Send through peer review process

Your collated PDF should now contain;
e The redactions marked up for review. &_ ,
e FEach redaction with a Text Box Iabellmgf,the reason (under the Official Information
Act 1982) why you intend to redant Tt:\\
e The collated PDF should have pa\ge nﬂmberlng and document numbering for ease
of reference. y N

When these steps are completed you- c?n,begm the Peer Review process i.e. give to peer
reviewer -> Negotiation and Settle nent manager -> General Counsel -> Deputy Director ->
Minister’s Office. {{ /P
N4
Ensure that you have sen /dogu ments to appropriate people external to OTS, to advise the
Y

documents are within sc6pe»for release, as per OIA release best practice.

// \)_ -
The Peer Rewewerh‘a‘s’*i\he choice of printing out the collated PDF for review or using Acrobat
Reader to mark chaﬂ%g% to the document with the Sticky Notes option. A quick guide on peer

reviewing usméAd@ae Reader (available on all OTS computers) is found in Appendix Two.

Page 27 of 41



PART THREE

Step 7: Apply final redactions C_)

1. When the documents have returned from the Minister's Office and you have completedany last
changes you are ready to permanently redact the sections you have marked up. %

2. To prevent accidental permanent redaction of the documents save a new ver: the collated

PDF. /<\

3. On the Redaction Toolbar, select the Apply Redactions tab. 2

s Help
E"Muhimmﬁn ‘9Cnmmm|-§ =) Sticky Mate @Tmﬁﬁs— - ‘él | =1 oM % O f "’1‘)‘35"1“'

® 173% - i B OE RS g Matk for Redaction Applym.,:n Redaction Properties [4) Search and Redact
balance about right. Have a think about it and see if you agree. dback is welcome, Regards

b
<

reverse the redactions.

5. Click OK to proceed. \Z\

Adobe Acrobat

4. A prompt will appear as below awarning that once you proceed, you will be unable to

sure you want to continue? i

ORTANT! During your next save, you will be prompted to rename your I
ocument. You may wish to choose a new name for your document in order to
| Q have one copy without redaction and another copy with redactions applied.

OK Cancel } |

Y RO BN FLErS e L T ~ = T ST T T S TP T SO N Ty iy
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6. The redactions will now be applied as shown in the example below. ( ’

) 20161011 OLASwox BA) :
Fle [dt View Document Cemments Fegms Jools Advenced Window Help

DS cater Bl contines (@) Secwes A sgn e [8] Foms o [y Molimeds - (5P Communt - | ) Solytle [ Totbiis & ) 1By = @ 4/ [
DB s NG Qe fim

il ;@'Mnunm.mzmi-i G appnpatuctons 4 ropetier <3 Search and ed

& My perception is that we have got the balance about right. Have a think about it and see if you agree. Any few\‘

i} Jon Cotton, your H&S rep. g

7. Click Yes to proceed and remove any oth@ﬁen data left in the document related to your
redactions.

Adobe Acrobat ‘" F3 .- " | - ——

i Would you also like w hine your document for additional document
information?

; [ FAlways perform %ited action:

Yes No

T RL T e I e RS T R — e = i
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8. A Results tab will appear on the left side of your screen. &'\

5. Uncheck the Comments and Markup checkbox. This will ensure all text boxes remain. ( )

10. Select Remove to remove the remaining hidden data in the collated PDF.

) 20161011 O Srree RAW i .. =
HeEﬁﬁmDnmwﬂCmmFmTuka-dep

{ D e B comtines ) sewer A S [B] Forne [y Witimetn s D Comment« | ) Sictytte [E] Tentrr &+ o] (B = Q2 / {V%ﬁ
OB BL eIk B o8 ,,4;]—. E’mmmmJ S Rgly Pastons \qm@lmmm

obligations that are either hlnderms people unreasonahly, or exposing people to unnecessary risks, ip.performing their daily tasks?

LN

Exam
My perception is that we have got the balance about right. Have a think about it and see if you a feedback is welcome. Regards

Jon Cotton, your H&S rep.

Q’}'

S5 20161011 0lASooo
B9 Metadota (Bitem

&y iterr
Comments and.
Bl et (L pag
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N
Step 8: Adding the OIA release watermark

1. The collated PDF is nearly ready to send to the requestor. It requires the watermark acrosé.ll)
the documents stating they have been “Released Under the Official Information Act”. vh

=

2. On the Document Tab select Watermark-> Add....
if -

=) 20161011 OlASinx P

File Edit View -__ _Toals Advenced Window Help i
| i) creatav | Header®Faoter > I- [®] Forms ~ [y Muttimedia = <P Comment~ | 0 Stick
iy =h 5 N ; “add.. ) % - H [ N \

L4
Extract Pages,.. Bemeve...
Replace Pages..,

Dglete Pages... Shift+ Ctrie D s
sl oings and Opportun
Crop Pages... ShifteCtrieT

Rofate Pages... Shifts CtrieR J

5% Sean to POF S I
Optinize Scanned PDF
OCR Text Recognition .

Reduce Fila Size...
Examjne Document...
Compare Dacuments,..

Add Bookmark Cul+B

3. Inthe Add Watermark properties box;

a. typeinthe text “RELEASED UNDER THE O@‘AL INFORMATION ACT” in capital letters
(on two lines as shown on the screen@ low);

b. setthe size of the font to 50;
c. select the colour red from the cqﬁ%xalette;
d. setthe Rotation to 45°; Q
e. set the Opacity to 40%; an
f. ensure that Appear on top m page is checked.
Add Watemak T - - ; ==
Souice Predes

RELEASED UNDER THE

PrgienPage [U i of8
& 1ea (JorAciaL miForraTION AcT 4%

THE VIBE

Absohte Scale:  f100%:

Appeanance
Rotation: - Nong @ 1 Custem FS' 5

e relatig to terget page. W%

Locatio 1 Appear behind page ¢ Appear antop of page

nce Option

Ciple  [<Movauree fle giected>

PageMymber: |7

VepalDisnce: [0 1 [Centimeters <] from [Center +]

HodgontalDistance: [0 | [Centimeters  +| from [Center ]

Hep
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¢\,
~ L/
U
&y f,’
\{ AY
o
Ny
V 4

5. You should now see the watermark printed across every page in the collated PDF.
- ‘ — T -y - SR

Rdaaced Vindow Hep
- [ Fomse g Menata s TP Commani v
e

Seichy Mete | | Tealaes o B { PR ST WP BN wa )

WAL T

_ﬁ RadactenPropetns <¥) Sewih bed Fedet

."\\:\l}
7. Break it down into smaller sections by scannifig ir}-)B*O or so pages at a time or alternatively send

it as a zip file.

8. This ensures your OIA sections will take g\:‘bﬁ?ideration of email size limits which are able to be

o N,

received by the requestor. ¢ N

Step 9: File the finalised.OIA
/}‘ r\
1. File the scanned final ve?s‘ibq of the OIA in the X:Drive and hole punch the physical copy ready

for filing by you or suppprt staff - as per the filing arrangement in your specific team.

&

L 9
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APPENDIX ONE: Converting file types to PDF

1. Converting emails
a. Right click on the email you wish to convert.
b. Select Convert to Adobe PDF from the dropdown menu.

fiew Tools Help \“’

\8|Open ~ Print New folder

Name Cate modified Type
|1 20160706 Ma,a“gaml, atahuianatha . 2MRONIER e Oudlodi ..{% 354 KB |
71120160801 _The Vibe -1, Open be Ayt 736 KB

33 2016_0815_The Vibe - Print afm m%h: 0. 954 KB
7-Zip g

oY 7
Open with... %
W Scanfor threats... <§/
Restore previous \remuns i
s

Sendto LN q‘\ »
W

'y,
c. Save the file using the fofmahexplamed in Step 1 (16).
i.e. “YYYYMMDD — OIA(CSXXX% DRAFT”, e.g. “20161031 OIA51234 RAW”

F,

Save PDF File As - ™ Ap—— )
SORE - )0 I eaan
Organize « New folder %:‘Q* = @

E Videos L MName \ﬁ& Date madified Type

Search Raw source el r

ﬁ-'.' 20160801 The V'bz 1 Augl6 2008/2016 810 a.en. Adobe Acio
v zoﬁoai%_{m Vibe - 15 July 16 2/08/2016 810 an.  Adobe Acro

:/s’:./? ;
:‘\ &

o, Sl
"

\\) R "
/ﬁnlg nm:@aranga mai eteiwi o ngd hapa Ngapuhn) v
(J}}}?ﬁfﬂpe‘ PDF files (*.PDF) .]

K E%Kide Folders I Save ] | Cancel ]
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1.2 Converting multiple emails at once

d. Select the emails you have previously saved to a folder.

e. Right click
s : e

GuU

on your selection — choose Convert to Adobe PDF.

File Edit View Toals Help
(O] Open

Organize « Print E-mail

A

7 items selected Cate modifieck: 5/12/2016 Tﬂj p.m.

New folder

“  Documents library
Bulk email test

Name

O

( ™

L 9
Iy,

A

¥

Arangeby: Folder v

m

L..l E OIA redagtion

reggpding BOPRC hui vith Central Agencies

0 Scanforthreats...

N ok
C_Z_ Convertto Adobe POF >

Sendto
\ SN, Cut
"
i » Copy
1) Date created: §
» Create shortcut
m Delete

¢

4_

f. A pop up box will appgﬁﬁ S

Lmi'iar to the one below.

.
[} Adobe PDF Status w

Create Adobe P
Created &,

Z

Pending : |?-

LD eitiha e b b 2h acliad fast

3

he following items i
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Y,
J/'.'Q;;\.
"

g. For each email date and name it and save to the folder where you kee&h@
individual PDFs. N

.

Save PDE Fite As E = : i ‘
U <N i DI [ seoo2eomiccrm g

@

Organize v New folder

»

MName Date modified

'@ Bay of Plenty Regional Council relaticnsh...  5/12/2016 2:47 p.m.

T Memo Style 57122016 2:54 p.m.

File pal .?zommvsm.uj’)\ e-\%}% _‘1
Save os type: |PDF files (*PDF) R = -

I
|
|
; “ Hide Folders

B ey
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2. Converting Word docs
a. Openthe Word document you wish to convert.
b. Select Save As > PDF from the dropdown menu.

all possible file types.

S

. e |
[.__‘l Word OptjonsHX Exit WWd“ vy

H9-0 ;:Herio.Minfﬂefi Mlcrosoﬂ _' _n_'r'.
2 ol cas y eview View e
Sa iy =
| New ve a copy of the document ‘ :j lﬁ] i Indent K
v & Word Document i £3 L Eteft 0m Z Before: 0 pt 2
“u | Savethefile as a Word Document. i Watermark Page Page || _._ .= =
L./ Qpen {1 v Color ~ Borders | E¥ Right: |0 \' y= After 10 pt - |
| w | Word Template =
| | I Save — | Save the document as a template that can S g .
| be used to format future documents,
g Word 97-2003 Document -
SaveAs > | 5= | cave a copy of the document that is fully |
;;; compatible with Word 97-2003. !
| r*; Print N oF OpenDocument Text
i @ Save the document in the Open Document
Format. |
P | Minister
&\ Prgpare ¥ PDF |
Publish a copy of the document as a PDF
= file. f
o seng i
Other Formats |
Open the Save As dialog box to select from i

Date modified

File name30160706_Marangs mai e te iwi o n-gi.hupﬁ-NgibD .

Hame Type
@ 20160801 _The Vibe -1 Aug 16 232016 810 am.  Adobe Acrol
@20160615_"\! Vibe - 15 July 16 2/05/2016 810 a.m.  Adobe Acrs

"

v |

Save as type: [PDF fites {*PDFy

7]

' Hide Folders
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3. Converting PDF/A files to standard PDF files
a. PDF/A files are different from normal PDF files in that they prohibit
ill-suited to long-term archiving i.e. editing. s. )

b. To change the format to a normal PDF file open the PDF/A file in Aﬂ%b:g
e
Reader (found on all OTS computers). @%

c. Atthe top of the page, just above your document, a bannﬁ% tbe displayed
as below ¥

() stecimcongiesthe At hsbescpoe o pretonitin

d. Click the Enable Editing button.

&«

e. The prompt below will pop up advisingz%%?mt the document will have the

restrictions of PDF/A files removed Click OK.

=)

Editing a PDF will cause the PDF tq}q er comply with PDF/A. Are you sure

-
Adobe Reader

]

IA you wish to continue?
i MOTE: If PDF/A compliance is N when the editing is complete, besureto ||
use File->Save As Other-» P%ﬁ

O
“ Q/ [ Cancel | :

w

f. Resave the filé?éither overwriting the original or saving a new version if you
want to‘keep-a PDF/A version for archiving.

{1 547 - Nghti Repua-Ngatiwai ki Aates update cn ratification voting resy

Edit iéw  Window Help
w0 I [139%
("i,s je=—————u—m
shoCins |
»
CteW €
CtdeD
g Y CleP
-V 1\\.\547 - Ngati Rehua...voting results.pdf INISTRY ¢
= Y 2\\..\547 - Ngati Rehua...results - Copy.pdf
{/@ 2\\.\Minerals Letter 15112015, pdf
= 4\\..\403 - Ngatikahu k...eremony report.pdf
W $\\.\512 Ngatikahu ki ..eeni Henare MP.pdf
B g fyofWw
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APPENDIX TWO: Peer reviewing using Adobe Reader /é

1. Adding comments ({ j)
a. Firstly —as peer reviewer — save your own version of the file for ed itiﬁ%jf
adding comments. i.e. “YYYYMMDD — OIA 5XXXX — PR”, e.g. "2016103 A51234

PR”
b. Open your version of the collated PDF in Adobe Reader (this %I}en by
default for most users). f& \
*\\

c. Click on the Sticky Notes symbol (speech bubble).

ﬁ?@lﬁlﬂllmﬁ'm”\’ﬁpdf - Adcbe Reader
File Edit Xiew Mindow Help

EEEEETE .g,q c +W|[:|[B| =)

N2 | N Fill & Sign
; H -] M - Lad -
; 7 ;
s Here I will name narﬁsﬁc use Aaron Randall, Tom Bisley, Sam
Py

-

" Anderson, Rosie
Jake Pollock, Zsofia Hellyer, Katherine Gordon, Marg Joiner and Ad
Hickey sweated the hours at dozens of hui, wananga and HEP meeti
mornings and weekends, and venturing as far south as Otautahi

done wonders with flight bookings and rental cars and meetiﬁ%&s

vyiuncler the stellar leadership of Maureen
| over the north over late nights, early
Janna, Lyndsay, Victoria and Jackie have

&
And the result, after all that, is what we wer Na%usr all along - a
feasible, inclusive pathway for Ngapuhi that responds to the Tribunal's

recommendations and which we hope willibe supported by most
Neoanuhi The nranncale are rallad M Qn Mai aftar tha famnane

d. Click next to the aﬁ f the document you want to comment on.
e. A text box will, ogeh on the right hand side of the page for you to write in
your commegnts.
2. Highlighting argi?for redaction in Adobe Reader
a. You maydiso ' wish to highlight sections of text for redacting (NOTE: This will
not \Aﬁ@r all PDFs as text highlighting only works if Adobe can recognise
tea(t\c%;the document in the first place).

£‘\‘ :)._TT=
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b. Select the Highlight Text icon and highlight any text you wish to bring to t

attention of the OIA owner. . %
i 20161011 OlASxxx RAW.pd| - Adobe Reader e - e m

File Edit View Mfindow Help
.....) l,ﬂ ﬂlla«sxi Commenl
= i

BE‘;%B'W;-{Eul---{- 1395 : |Ej]£:«)i()
~ “\ R~ i 5 & L
i Herelwill name names, because Aaron Randall, Tomy % isley, Sam |

Anderson, Rosie Bat
Jake Pollock, Zsofia Hellyer, Katherine Gordon, Marg Joiner and Adam Levy under the s
Hickey sweated the hours at dozens of hui, wananga and HEP meetings all over the north ovi
mornings and weekends, and venturing as far south as Otautahi as well. Janna, Lyndsay, Victag|
done wonders with flight bookings and rental cars and meeting rooms.

: |
1 % (S
%ﬁ

c. Using Sticky Notes to identify pictures, sh L{gﬂon text and text that cannot
be read by Adobe Reader will be adequa‘%{or the purpose of peer reviewing.

217 KIRKHAM =
1171072016 1:34:46 p.m.

‘Redact this picture - Wsborind

P

Kia ora koutou,
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APPENDIX THREE: Reasons for withholding information ( up to date as of 1 Aprll 4
2017) o~

Excerpt from the Official Information Act 1982 for commonly used reasons\\\

9 Other reasons for withholding official information

(D Where this section applies, good reason for withholding official mformatwm N
exists, for the purpose of section 5, unless, in the circumstances of the pai\tlcu ar
case, the withholding of that information is outweighed by other cons;ﬁeratlons
which render it desirable, in the public interest, to make that mformaﬂflon
available. :

(2) Subject to sections 6, 7, 10, and 18, this section applies if, and oﬁj{\if: the withholding
of the information is necessary to— 8
(a) protect the privacy of natural persons, including thaﬁoﬁdgceased natural

persons; or
(b) protect information where the making available d{thgg mfcn mation—
(1) would disclose a trade secret; or \.é” ¥ i
(ii) would be likely unreasonably to plele{iIG& the commercial position
of the person who supplied or whg‘IsThe subject of the information;
or

(ba)  protect information which is subject, tp anﬁbhgahon of confidence or
which any person has been or could b@ compelled to provide under the
authority of any enactment, whf?{re the-making available of the information—
(i) would be likely to prejudice the supply of similar information, or
information from thg sgl’ne source, and it is in the public interest
that such 1nf01mat;0n ‘should continue to be supplied; or
(ii) would be likely ofhﬁwvlse to damage the public interest;
(c) avoid prejudice to me@suﬁs protecting the health or safety of members
of the public; or

(d) avoid prejudice toﬁﬁe Spbstantlal economic interests of New Zealand; or

(e) avoid prejudice fexn{eé’smes that prevent or mitigate material loss to
members of thés ﬁb ic; or

D maintain thexéonst tutional conventions for the time being which protect—
(1) the confi dentiality of communications by or with the Sovereign or

]jicg ‘representative:
(ii) ,/ sollective and individual ministerial responsibility:
(111) tjle political neutrality of officials:
] ) the confidentiality of advice tendered by Ministers of the Crown
" and officials; or
ntain the effective conduct of public affairs through—
the free and frank expression of opinions by or between or to Ministers
of the Crown or members of an organisation or officers and
employees of any department or organisation in the course of their

duty; or
(ii) the protection of such Ministers, members of organisations, officers,
o’ and employees from improper pressure or harassment; or
{\;;12;5-2- (h) maintain legal professional privilege; or
E ’ >§ (i) enable a Minister of the Crown or any department or organisation holding
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the information to carry out, without prejudice or disadvantage, commercial
activities; or jj ~,

§)] enable a Minister of the Crown or any department or organisation holding Q’ }
the information to carry on, without prejudice or disadvantage, negotiations .-
(including commercial and industrial negotiations); or %z‘:’

(k) prevent the disclosure or use of official information for improper gain‘er
improper advantage. Q%:v

Section 9(2): amended, on 1 April 1987, by section 4(2) of the Official Information Amendment Act ;3
1987 (1987 No 8). K
Section 9(2)(b): replaced, on 1 April 1987, by section 5(1) of the Official Information Amendme

Act 1987 (1987 No 8). -
Section 9(2)(ba): inserted, on 1 April 1987, by section 5(1) of the Official Information Ameny ﬁ%{

Act 1987 (1987 No 8). K

Section 9(2)(g)(i): amended, on 1 April 1987, by section 5(2) of the Official Information Al ment

Act 1987 (1987 No 8). iy

Section 9(2)(g)(ii): amended, on 1 April 1987, by section 5(3) of the Official Informa mendment

Act 1987 (1987 No 8). d
Section 9(2)(i): replaced, on 1 April 1987, by section 5(4) of the Official Information Amendment

Act 1987 (1987 No 8).
Section 9(2)(j): replaced, on 1 April 1987, by section 5(4) of the Official Inf()fg}én Amendment

Act 1987 (1987 No 8). X
&
\/
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Office of Treaty
S_ettlements

| Takn B pA AN

PART OF THE MINISTRY OF JUSTICE 1
Reasons for withholding under section 9 of the Official Information Act 1982

59(2)(a) — protect the privacy of natural persons, including the deceased.
5 9(2)(b) — protect information that would:
(i) —disclose atrade secret;
(i) —unreasonably prejudice commercial position of subject.
s 9(2)(ba) - protect information where making it available would:
(i  —prejudice the supply of similar information; or
(i)  —likely otherwise damage the public interest.
5 9(2)(c) - prejudice to measures protecting health or safety of the public.

5 9(2)(d) — prejudice to sut ial ec erests of New Zealand.

59(2)(e) — prejudice to measures that prevent or mitigate material loss to members of the public.

DOCUMENT

DOCUMENT DESCRIPTION

NUMBER

s9(2)if) -

0]

(i
{iii)
(iv)

s9(2)(e) -

0]

i)

Vv

Table of documents released under Oﬁicialrtii%rmation Act 1982

I
%

maintain the <oqf§ubﬁ:nal conventions which protect:

~ communicatiohs By or with the Soverelgn or their representative; or

— collective ihrcl_lndividual ministerial responsibility; or

— the po) \:\‘I:‘;\;ulrallly of officials; or

—the R«d{ﬁ ntiality of advice tendered by Ministers and Crown officials.
ma; taifrthe effective conduct of public affairs through:

—the free and frank expression of opinions;

-,—\ e;rolec‘riun from improper pressure or harassment.

s 9(2)(hh—~$31nlain legal professional privilege.

- ehable the Crown holding the information to carry out commercial activities.

so{2)(ij:
sz(z] - negotiations sensitive,
p’s (2)(k) - prevent the disclosure of information for improper gain or advantage.

5

PAGE

REASON FOR WITHHOLDING NUMBER

dd/mm/yyyy | e.g. letter, email, report (J ) e.g Released in Full, s 9(2)(a) 1

a4
2 .74
2A e.g [Attachment-Document Descrl‘ptibn]
3 47
4 ANEY
5 N
6 R
7 X
8 SN

3
~J

! Please see the Official Information Act 1982 foéf_ﬁ;ljzversion of section 9 of the Act.

o~
{{,r{
:</>/
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